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What is inside a PC (Personal Computer)?
computer is simply a counting machine which processes information in the form
of binary numbers; it can do millions of binary calculations a second (the binary
system is a counting system that uses the numbers one or zero (and not zero
through nine) to represent any information.
The computer has a variety of different parts, categorized under either hardware
or software.
Hardware is the physical parts we have in out computer like (Hard disk, monitor,
mouse, keyboard, etc), while Software is the operating system (OS) like
Microsoft™ Windows™, and the programs we run under that Operating System.
There are other Operating Systems, but Microsoft Windows™ is definitely the
most widely used.
Computer Hardware components
Each part in a computer has a different role to perform, just as every part
in an automobile has its function. Each part plays a different role, and
together they make a great team which is called a Personal Computer, PC.

CPU or processor

A CPU stands for central processing unit, which is also known as
"processor".

It is the brain of a computer because It does all the calculations (It adds,
subtracts, multiplies and divides a multitude of numbers) in the binary
system to make software (Operating System and programs) run. When you
hear people talk about a "Pentium", they refer to the brand or type of
processor.
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Hard Drive or Hard Disk

A Hard Drive is a storage device on a computer; it contains all operating
system files, programs and data created by a user.

A hard drive is sometimes called a "hard disk”. The name came from
being fixed to the computer but to describe it, a hard drive is a bunch of
disks, which spin very quickly, located inside a case.

To read or write information from and to the hard disk, it has "heads" to
do the job. The heads are very similar to the arm of a record player. They
move back and forth over the surface of the spinning disks.

Hard disks have different sizes, which are usually mentioned in Gb
(Gigabytes, one gigabyte equals one billion bytes). You can have more
than one hard drive in the computer.
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RAM stands for Random Access Memory or simply "computer memory."
This is where the computer performs short term tasks.

When a program runs or a file opens, a copy is retrieved from the hard
disk so the CPU —in turn— sends the data to the memory where
calculations are made.

RAM is sometimes confused with Hard Disk, because both store data. But
there are huge differences between the two: The RAM holds data when it
flows through it. It is much faster than the Hard Drive, but it’s also
expensive. RAM is the interface between the Hard Drive and the
Processor. The data stored in RAM is volatile, which means if the
electricity goes off, all unsaved data is lost. Data on the hard drive
remains, even when there’s no power.
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Floppy Drive

The Floppy Drive is an external storage media. The Floppy drive uses
floppy diskettes to save data but the size is limited and they get damaged
easily if not saved in a proper place.
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Video Card

The Video Card, also known as “Display Card”, or “Graphics card” can
be built-in on the mother board or separately installed.

The old type was PCI cards, but most cards are now based on the AGP
standards.
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Sound Card

As the name says, the Sound Card is used for making the sound that
comes out of the computer. It is used for most of the computer games,
playing movies, music and can greatly help people with sight limitations!
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Network Card

The Network Card has become a common piece of the computer to
connect the computer to an internal network to make the computer able to
share documents and printing facilities with other computers in the
network.

It has speeds ranging from 10 to 1000 Mbps (Mega Bits Per Second).

Modem

Modem stands for modulation / demodulation and is used to connect the
computer to the Internet through a “dial-up” connection.

It can be also used for sending and receiving facsimiles. These “faxes” can
then be saved on the computer as separate files for future use.
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E-mail and How to use it
Electronic mail, or as we call it, e-mail, is the process of sending messages using
a computer connected to the internet. Anyone can send messages when it is

convenient for him, the recipient responds at his convenience.
Emails can be sent using your computer if it’s connected to the internet. What

makes Email is a very powerful way of communication is that it is instantly
delivered, very cheap to use and can be used to send electronic files of any type

like text, spreadsheets, images and all other kinds of files.
The e-mail can be sent to one recipient or even hundreds with a failure notice if

delivery fails and optional successful delivery notice.
What can you do with emails?

. Send messages, memos and files.

. Receive and read messages and save files for future use.
. Reply and forward messages

. Send the same message to many receipts with one click.
. Save email to a file (Archiving) and print the message.

What does an Email Address look like?

To receive or send email anyone needs to have an email address and needs
to know the address of the receipt or receipts.

The e-mail looks like:

amgadm@yahoo.com

Where:

Amgadm: is the user identification which could be your first name only,
first and last name, nick name.

@: Separation symbol must be used to separate the user identification and
the domain name.

Yahoo.com: is the domain name where your e-mail address is hosted on.
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Types of e-mail clients
To use the e-mail you need an e-mail client which can be either a:
. Web-based e-mails: Like Hotmail, yahoo and Gmail which
requires a web browser like (Internet Explorer, Fire Fox, Netscape) to
access the e-mail.
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o Operating system based clients: Like Outlook, Outlook express
and Eudora, which are separate program configured to access your e-mail
account, and they have many advantages than the Web-Based e-mail
clients: offline access to old e-mails, creating draft messages, can access
many e-mail accounts in the same time, can be accessed with different
users each will have access to his own account only using different profile,
automatic archiving..............
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Although e-mail has become very critical and useful way of
communications and documentations, it can be used for sending viruses,
junk mail, and offensive materials!

Let’s briefly go over the advantages and disadvantages of E-mail:

E-mail system advantages:

. E-mail is fast. With electronic mail, the delivery of messages is
instant, which means that it may take up to few seconds to be delivered. If
the server, where the e-mail is sent, is down for any reason, the sender’s
server will continue trying to send the message for a certain time up to a

whole day or so depending on the configuration of the sender’s server.
. E-mail is an asynchronous communication system, which in

simple words means: communication that does not happen at the same
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time. In e-mail, the sender sends an e-mail and the recipient reads it at
his/her own convenience. This feature is very useful for communicating
between different world time zones.

. E-mail is cheap. E-mail allows you to have a huge number of
correspondents, over a huge wide geographical area with the cost of as
low as a single local call.

E-mail system disadvantages:

. Security and privacy are low with e-mail. Although many
antivirus software are now offering great tools for protecting the e-mails
from harming your PC, everyday we get new viruses and worms in place

which requires up to date antivirus software.
. The majority of the e-mails sent are delivered to the correct e-mail

addressee without a problem. Sometimes, however, messages may be
intercepted by individuals other than the original sender or targeted
recipient. This could occur because of an incorrect e-mail address written.

. Many companies use the e-mail now to send free advertisements,
which is so annoying to the people who receive it.
. E-mail is used to send offensive materials like unsolicited sales

offers and adult materials
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What is browser software?

A browser is a piece of software you use to view the information on the Internet
graphically and to surf different sites. If you are using any version of windows
starting from Windows 95 and later or Macintosh 8.5, Microsoft Internet Explorer

(knows as IE) should already be installed on your computer.
Upgrading the browser can be downloaded from the Internet (these programs may

take some time to download) or be purchased from computer stores.
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Internet Explorer

The word Browser stands for Web browser, a software application used to locate
and view Web pages and other functions like Chatting, downloading and
accessing remote computers.

The two most popular browsers in the market are Netscape Navigator and
Microsoft Internet Explorer. Both of these two browsers are called graphical
browsers, which mean that they can display graphics along with text.

In addition to that, most new versions of these browsers can present multimedia
information and files, including sound and video, though they sometimes require
plug-ins for some formats.
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Netscape Navigator

Browser features

Most of the web browsers have many features to make surfing the internet
more convenient and easy for the net surfers, like favorites, cache and
history.

New browsers like Fire Fox allow you to navigate more than one page in
the same time in the same window which gives it a big advantage over
other web browsers.

What is Browser favorites?

The browser’s favorites are used to save the links of the sites you visited
and want to keep for future use. When you visit a web site you may not
easily remember its URL (Universal resource locator) which looks like

http://www.hotmail.com that is the address of the site you visited.

If you want to revisit that web site, you need to type its full URL, what if
the URL is not short as the example we mentioned and look like the
following:
http://www.rentacoder.com/RentACoder/misc/BidRequests/ShowBidRequ
est.asp?IngBidRequestld=354708&txtForceRefresh=10302005315735205
Also, you can extract this list and keep it when export it to other
computers, modify it as needed and even share it with others.

What is Browser History?

Your web browser keeps a record of all of the web sites you visit. This is
called what we call "Browser History". This history is save on the
computer , so you can check it in future if you need to go back to a
specific web site you visited and you can not remember its complicated
URL.

What is Browser Cache?

In order to view any web page, your web browser will download a copy of
that page to your computer. These copies are used to be loaded the next
time you visit the same page in case the page has not been updated.
Although the browser cache is very useful, it consumes huge space on the
hard disk of the computer, and auto clean up should take place every now
and then to free this space.

More advanced technique are used when using a caching server, which
allows more than one machine to access the same page from cache for
faster performance and to save clients hard disk space.
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How to Install a Toolbar
The internet has many features to use, and everyday we find new software and
tools in the market for more simple and convenient use.
To access the internet, you need a browser which is the software to surf and
browse into the huge world of internet. The browser can have additional software
which gives the user more tools. One of the most important software is the
browser toolbar like the Google Toolbar or Yahoo Toolbar.
For example, the features of Google toolbar are:
- Spell Check: Check your spelling whenever you type in web form
- Word Translator: Translate English words into other language
- Auto Link (US only): Turn street addresses into links to online maps
- Search with Google from any web page
- Block annoying pop-ups
- Automatically fill out forms for faster online shopping
Advanced features include:
Google Search
Keep the power of Google search close at hand. Google Toolbar puts a search box
in your browser, making it easier than ever to find anything you want on the Web.
Address Bar Browse by Name (Internet Explorer only)
Browse by Name helps you find a site even when you don't know its URL. Just
type the site name into your browser address bar, and Toolbar will take you there
automatically. For instance, try typing "oxford" into the address bar to go directly

to the university's home page at www.ox.ac.uk.
If you type in something that doesn't have an official home page, like "digital

cameras," Browse by Name will automatically show you search results for that
term

Pop-up Blocker (Internet Explorer only)

Lost in a jungle of annoying pop-up ads? Toolbar's pop-up blocker keeps your
screen free and clear.

AutoFill

Tired of typing in your address and credit card information every time you shop
online? AutoFill makes shopping a breeze by enabling you to fill out web forms
with a single click. Just enter your info once in the Toolbar's Options dialog box
and you're ready for an online shopping spree. (Note: your credit card info stays
password-protected.)

PageRank Display

Wondering whether a new website is worth your time? Use the Toolbar's
PageRank™ display to tell you how Google's algorithms assess the importance of
the page you're viewing. A rank of 0 tells you the site is in its infancy. A rank of

3-4 is pretty good. A rank of 6 and above signalizes a monster.
So, how do you download and setup this toolbar on our machine?
You can download the software from http://toolbar.google.com/
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SpoliCheck

Check your spelling whenever you type in web forms
WordTranslator

Translste English words into other languages

AutoLink (US only)
Turn strest addresses into links to online maps

Maore features

* Search with Google from any web page

+ Block annoying pop-ups

+ Automatically fill out forms for faster online shopping
Talke the tour - View gl fegtures

It's free and takes seconds to install

Download Google Toolbar

Other languages: | Select a language v

Syslom roquiromaonie:
" Windowe BRMELDO0KP

FEirefox version now available

Before installation you should check that you have the following system
requirements:

* Operating system : Windows 98/ME/2000/XP

* Internet Explorer 5.5+ ( to use the features Spell Check and Auto Link, it require
IE 6.0+)
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The second way of installing the toolbar is to download it from the web site
directly — not to the hard disk first.

Lﬁ Google

Toolbar

System Requirements

o Microroll Windows

o Microsoft Internet Exphorer version £ or later
{The papup Blocker requares Intemict Explorer £ 5 or dnter)

Please note that the instaflation of the ioolbar will return Internet Explores’s script error seftings to their defonll configuration According to ths confiparstion the option to Tisable
script debiggmp will be activated and the optios to Deplay 8 notificaton sbout svery scrgst emmor will be haned off

install the Google Toolbar
By mstalling the Google Toolbar vou agree to abide by owr Termi of Use

Close All Other Browser Windows Before Proceeding.

1 | AGREE TO THE TERMS OF USE - INSTALL THE GOOGLE TOOLBAR ] |
To do so, go to: http://toolbar.google.com/install
Read the terms of use, by clicking on the link saying Terms of Use.
Then, you click on the bar titled: | AGREE TO THE TERMS OF USE —
INSTALL THE GOOGLE TOOLBAR
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The next window will ask you to install either the normal features or advanced
ones.

- Google-

Toolbar

G% choose Your Configuration

PLEASE READ THIS CAREFULLY
IT'S NOT THE USUAL YADA YADA

By uning fhe achanced feahares of the Google toclbar, you may be sending udformation aboit the stes you sl 1o Google. Thn n nesded to make somme featires of the Toalbar
avadable to vou

In order to show you more information about 2 sie, the Google Toolbar has to tell s what gt you're visting. which k does by sending us the URL
Thas does NOT 1ol us whe YOU me (your ammne of conad address), bt it does iell us that o wser has requested the PapeRank for a given siie

Crsogle will not asll or provide persomally ideptffiable sformasion to mry thrd parties. To leam more shout the privacy protections we e buil pio tee oystem, read our Toolbar
frivacy policy

I INSTALL WiTH ADVANCED FEATURES ]

Emables achvanced functionality and mmomatically sends the URL of the current page 1o Google.

1 INSTALL WITHOUT ADVANCED FEATURES |

We understand md respect vour privacy concerns. By selecting this option, you =il not heve acorss to advanced fimctionality. However, no iformation about the shtes vou vist wil
b compmmucated to Google

When you choose, you will end up installing the toolbar on your computer and
use the great features of the toolbar.
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Searching the internet
Your capability to search the information on the Internet is a consequence of how
exact your queries are and how efficiently you make use of search services. Poor
queries come back with poor results; good queries come back with good results.
Opposite to the hype of nearby intelligent agents and artificial intelligence, the
truth is that search results are simply as good as the query you ask and the way
you search.

There are very efficient ways to arrange queries and use certain operators to
object the results you search for. Missing these techniques, you will waste your
time looking at ineffective documents that don’t contain what you want. Or you
will stop in annoyance after search reviewing long lists of documents until you
find what you want.

1. Usually we use nouns and objects as our query keywords.
Example: we write the keywords to look like system or systems

Why is this Important? Actions like verbs, modifiers like adjectives,
adverbs, predicate subjects, and conjunctions are ignored by the search
engines or too much variable to be helpful.

2. We should use six to eight keywords in query.
Example: we write the keywords to look like old, planet, planets,
discover, solar, system

Why is this Important? More additional keywords, selected at the proper
level, may decrease the universe of possible search results returned by
99% or even more.

3. Truncate keywords to select singular and plural versions.
Example: we write the keyword plus “*” to look like planet* or
discover*

Why is this important? By using the asterisk (*) wildcard, the wildcard
informs the search engine to match all characters which follow it, saving
keyword slots and rising coverage by 50% or even more.

4. We should also use synonyms by the use of the OR
operator.

Example: we write the keywords plus “*” plus “OR” to look like
discover® OR find

Why is this important? Cover the possible different ways a thought can
be described; in general stay away from OR in another case
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5. Also combine keywords into phrases wherever possible.
Example: we write the keywords to look like "solar system™"

Why is this important? Use quotes to represent phrases. Phrases limit
search results to EXACT matches; if joining terms is a natural marriage,
narrows and targets results many times.

6. Combination of two to three "concepts" in query will make

the search more specific.
Example: we write the keywords to look like "solar system”, "old
planets*", discover* OR find

Why is this important? Triangulating on many query ideas narrows and
targets results, in general by more than 100 to 1.

7. Differentiate "concepts" with parentheses.
Example: we write the keywords to look like ("solar system") ("old
planet*") (discover* OR find)

Why is this important? Nest every single query "concept" using
parentheses. (Too much for now, but good practice when first learning.)
Simple way to ensure the search engines evaluate your query in the way
you want, from left to right.

8. Order "concepts" with subject first.
Example: we write the keywords to look like ("new planet*")
(discover* OR find) ("solar system")

Why is this important? Put main subject first. Search engines tend to
rank documents more highly that they match first terms or phrases
evaluated.

9. Link "concepts" using the AND operator.

Example: we write the keywords to look like ("old planet*") AND
(discover® OR find) AND ("solar system")

Why is this important? Operator AND glues the query together. The
resulting of that gluing query is neither overly sophisticated nor nested.
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Advanced Search on The Internet
When you know the basics of any search engine, you may want to try Advanced
Search, which offers several options for précising your searches and getting
further useful results.
We will use Google.com (one of the most known search engines in these days) as
an example:
You can find this page by clicking the "Advanced Search" link on the
Google.com home page.
Here's how the Advanced Search page looks like:
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You can do many more with Google search than only typing in search terms.
With Advanced Search, you can search just for pages:

. which contain ALL the search terms you type in

. which contain the exact phrase you type in

. which contain minimum one of the words you type in

. which do NOT contain any of the words you type in

. are written in a certain language

. are created in a certain file format

. which have been updated within a certain period of time
. which contain numbers within a certain range

. are within a certain domain, or website

. which don't contain "adult" material
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Using advanced search "operators"”
In addition you can improve your searches by adding up "operators" to
your search terms in the Google search box, or choosing them from the
Advanced Search page.
Using advanced search operators include:

Include Search

Synonym Search

OR Search

Domain Search

Numrange Search

Other Advanced Search Features

Using''+'" search

The search engine (Google) ignores common words such as where, the,

how, and other digits and letters that delay your search without improving

the results. We shall indicate if a word was excluded by displaying details

on the results page under the search box.

If a common word is necessary for getting the results you want, you may
include it by putting a "+" sign in front of it, and be sure to include a space
before the "+" sign.

As an example, here's how to make sure that Google includes the "I" in a
search for Star Wars, Episode I:

Star Wars Bpisode +| Google Search |

SN kv =
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Using synonym search

If you want to search not just for your search term but additionally for its
synonyms, place the tilde sign ("~") directly in front of your search term.
As an example, here is how to search for food fact, nutrition and cooking

information:

~food ~facts Google Search

{

Using"OR" search

To find pages that include one of two search terms, put in an uppercase
OR between the terms.

As an example, here is how to search for a vacation in either London or
Paris:

vacation london OR paris Google Search |

Using domain search

You may use Google to look for only within only one specific website by
entering the search key words you're looking for, followed by the word
"site" and a colon followed by the domain name you want to search in.
As an example, here's how you would find admission information on the
Cairo University site:

adrrission sit e wew cairo.edu.eg Google Search
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Other useful advanced search features

. Google Local: looking for products and services in a specific U.S.
town,city or zip code.

. Language: specify in which language you would like your results.
. Technology Search: find information related to specific thing like
Apple Macintosh, BSD Unix, Linux or Microsoft.

. Date: restrict the results to the past three, six, or twelve month
periods.

. Occurrences: specify where your search terms should occur on
the result page - anywhere on the page, in the title, or in the url.

. Domains: search only a specific URL or website, or exclude that
site from your search totally.

. SafeSearch: Eliminates sites that contain adult contents from

search results.
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Simple editing

Typing text and the Backspace Key
How to enter and delete text? To enter text, just type as you would when
using a typewriter. To make capital letters, hold down the Shift key as you
type the letter. Press the Backspace key to delete text. You don’t need to
use Enter to start a new line. Any word editor will wrap at the end of the
line. Use Enter to start a new paragraph.

Using the Delete Key
In addition you can delete text by using the Delete key. First, select the
text you wish to delete; then press the Delete key.

Inserting Text
You can also insert text. To do so, your editor should be in Insert mode.
To check whether it is in the Insert mode or not, take a look at the Status
bar, located at the bottom of the screen. Take a look at the right side of the
Status bar. If the letters "OVR" are colored in gray, it is in Insert mode. If
the letters "OVR" are colored in black, it is in Overtype mode.

(7 |

Insert MMode

(B2

Cvertype Mode
If you want to change to the Insert mode:
1. Double click the letters "OVR."
2. The letters "OVR" are now colored in gray.

An alternative Method.: Setting Options by Using the Menu

You may also use the menu to change to the Overtype mode.

1. Select Tools Then Options from the menu. The Options dialog box
will open.

2. Use the Edit tab to choose the Edit tab.

3. The Overtype Mode box must be blank. If it is blank, then click
OK.

4. If the Overtype Mode box isn’t blank, then click the box to get rid
of the check mark. After that click OK.

Another alternate Method: Setting Options by Using Key
You may use the keyboard to transform to the Overtype mode.

1. Click Alt-t, o.
2. Use Edit.
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3. Click Alt-v (toggles between overtype and insert).
4. Click Enter.
Overtype

You may replace the current text with new text. But, you have to be in the
Overtype mode. Do as follows to transform to the Overtype mode.

1. Double Click "OVR" the Status bar.

2. The letters "OVR" must be black.

Bold, Underlined, and Italicized
You may bold, underline, or italicize while using Word. You may also
combine these features; there are three different methods for bolding,
italicizing, or underlining while using Word.
Bold text, Using the Menu
1. On the line that starts with Menu, select the word Bold. To do that,
put the cursor before the letter "B" in "Bold." Click the F8 key; then click
the right arrow key until the entire word is highlighted.
2. Select Format > Font from the menu. The Font Dialog box will
open.
3. Press Bold in the Font Style box.
Notice: You may see the result of your selection in the Preview window.
To turn off the bold, press Regular.
4. Press OK to close the dialog box.
5. Press anywhere in the text area to remove the highlighting. You’ve
bolded the word.
An alternative Method: Bold by Using an Icon
1. On the line which begins with "Icon," select the word "Bold." To
do that, put the cursor before the letter "B" in "Bold." Click the F8 key;
then click the right arrow key until the entire word is highlighted.

2. Press the Bold icon B on the toolbar.
Notice: To switch off bold, select the text and click the Bold icon again.
3. Press anywhere in the text area to remove the highlighting.

An alternate Method: Bold by Using the Keys

Italicize, Using the Menu

1. On the line that starts with "Menu", select the word "Italicize." To
do that, put the cursor before the letter "I" in "Italicize." Click the F8 key;
then click the right arrow key till the entire word is highlighted.

2. Select Format > Font from the menu.

3. Press Italic in the Font Style box.

Notice: You may see the result of your selection in the Preview window.
To turn off the italics, press Regular.

4. Press OK to close the dialog box.

5. Press anywhere in the Text area to remove the highlighting.
An alternate Method.: Italicize by Using an Icon
1. On the line that starts with "Icon," select the word "Italicize." To

do that, place the cursor before the letter "I" in "Italicize." Click the F8
key; then click the right arrow key until the entire word is highlighted.
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2. Press the Italic icon 4 on the toolbar.

Notice: To switch off italics, select the text and click on the Italic icon
again.

3. Press anywhere in the Text area to remove the highlighting.

An alternate Method.: Italicize by Using Keys

Underline, Using the Menu
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You may underline when using a text editor. The following are some
examples of underlining:

This 15 a single underline.

This 1s a words only underline

This 1z a do mne

This 12 a dotted underline.

This 15 a thick underline,

This 15 a dash underline.

This 15 a wave underhne,

The following is how to underline by using the menu:

1. Highlight the word(s) you want to underline.

2. Choose Format then Font from the menu.

3. In the Underline Style box, click to open the pull down menu.

Choose the type of underline you wish to have.
Note: To remove an underlined text, you choose None from the pull down

menu.

4. Click OK.

5. Click anywhere in the Text area to remove the selection.

An Alternative Method -- Underline by Using the Icon

1. On the line that begins with "Icon," select the words you want.
2. Click the Underline icon u on the toolbar.

Note: To switch off underlining, press the Underline icon again.

3. Click anywhere in the Text area to remove the selection.
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How to Copy and Paste text
In a text editor, you may copy text from one area of the document and
place that text in another place in the document. Like with cut data, copied
data is kept on the Clipboard.
Copy - Using the Menu
1. Highlight the text you wish to copy.
2. Choose Edit > Copy from the menu.

Paste - Using the Menu

1. Place the cursor where you want to paste.
2. Click Edit > Paste from the menu.
Alternate Method -- Copy by Using the Icon

1. To copy you can use the icon:
Alternate Method -- Paste by Using the Icon

1. To Paste you can use the icon '5

Notice that all images are taken from the current version of the actual
software: If you run older (or newer) versions, colors may be different, but
the icons themselves should be similar.

They are also pretty common standards across many software products.
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Temporary internet files
The Temporary Internet Files folder contains Web pages content which is stored
on your hard disk for fast viewing. This folder allows Internet Explorer or MSN
Explorer to download only the content that was changed since you most recently
searched a Web page, instead of downloading all contents for a page whenever it
is displayed. To remove the files in the Temporary Internet Files folder, follow
the steps below:

1. Close Internet Explorer and close any instances of Windows Explorer.

2. Press Start, then press Control Panel, and then double-click Internet
Options.

3. On the General tab, press Delete Files under Temporary Internet Files.

4. In the Delete Files dialog box, press to select the Delete all offline content,
check box, and then press OK.

5. Press OK.

Generally:

o If the Temporary Internet Files folder contains a considerable amount of
Web page content, this process could take several minutes to be completed.

. An administrator may customize the Temporary Internet Files settings and
prevent you from changing them, as an example, by deleting the General tab from
the interface in the Internet Options dialog box. If you are not able to access the
Internet Options dialog box or the General tab, call your administrator for more
information.

o Files which begin with the word "Cookie" could remain in your Temporary
Internet Files folder after following these steps. These files are like pointers to the
real cookie files that are found in your Cookies folder
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You may experience the following symptoms

o Your Temporary Internet Files folder could use additional disk
space than you specified in Amount of disk space to use. To find Amount
of disk space to use, press Settings on the General tab of the Internet
Options dialog box.

o Files which are downloaded from Web sites could remain in your
Temporary Internet Files folder, but they are not visible in Windows
Explorer, after you press Delete Files on the General tab of the Internet
Options dialog box, and after that press to select the Delete all offline
content check box.

o To work about this trouble, shift your Temporary Internet Files
folder to a new location, remove the old folder, and then return your
Temporary Internet Files folder back to their original location:

1. In either My Computer or Windows Explorer, create a new
directory.

2. In Internet Explorer, press Internet Options on the Tools menu.

3. On the General tab, press Settings under Temporary Internet Files.

4. In the Settings dialog box, press Move Folder under Temporary
Internet Files folder.

5. Open the directory that you created in step 1, then click OK.

6. If you’re prompted to log off, press Yes, and then log on to
Windows once more. If you aren’t prompted to log off, press OK to close
all of the dialog boxes.

7. In either My Computer or Windows Explorer, remove the previous
Temporary Internet Files folder, then create a new folder in the same

location using the same name.
8. Repeat steps two till six again, except for step five, press to select
the new folder that was created in step seven.

NOTE: You should repeat this process when logged on for each user of
the computer.
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How to choose your internet browser
We will use Opera, Internet Explorer and Mozilla as our browsers to choose from.

32

Whoever spent some time browsing and searching on the Internet knows well the
wars between users of different internet web browsers. There are many arguments
for each browser. These days, amongst many to choose from, there are available
three browsers that are the most popular ones: Microsoft Internet Explorer, which
has about 90% of the market share, Mozilla and Opera — which has been gaining

growing popularity.

But which of these three browsers is the best, and for which user - this is a user
decision to make. Those who do not have too much time to spend, or do not want
for some reason to test each program, are recommended to go through this table,
which compares the most important features of these web browsers.

between windows and
the Taskbar

Browser - Microsoft Mozilla Opera
Internet
Explorer
Basic technical data
Engine Internet Gecko/NGLayout Presto
Explorer, based (authorship of
on NCSA Opera Software)
Mosaic
Placed in other yes, yes, yes,
software or hardware | For example in many other browsers, | i.e. in cell
(integration with other | multiple covers, | i.e. Galeon, Netscape or | phones or
software) adding features | Beonex palmtops
to main browser
Systems compatibility | Microsoft Microsoft Windows, Microsoft
Windows, MacOS X, Linux, BSD, Windows,
MacOS (not Solaris, BeOS, OS/2, MacOS, MacOS
developeed, but | QNX, Irix, HP-UX, X, Linux, BSD,
still supported) | OpenVMS, AIX, and Solaris, BeOS,
anyone with POSIX 0S/2, QNX,
recomendation with gtk SymbianOS
or gtk2 library
(possibility to compile
source code)
Browser’s Add-ons, improvements and tools
Supports Browsing no yes Yes
with Tabs
Easy to move tabs no no Yes

© 2005 SilverCitizen.com



http://www.silvercitizen.com

How to choose your Internet Browser 33
Caching Back/Forward | no no Yes
sites in system
memory
Supports Pop-up yes yes, with possibility to yes, with
windows blocking disable for selected sites | possibility to
open requested
pop-ups only
Can Open multiple no yes Yes
sites in tabs at browser
starting
Supports displaying on | no no Yes
small screens (cell
phones)
Supporting animated no no Yes
graphics MNG
Keywords for no yes Yes
bookmarks in the
address bar
Allowing Saving sites | yes yes Yes
with all settings,
graphics, styles and
other add-ons
Allowing Print yes yes yes
preview
Can do browsing on yes yes Yes
full screen
Supports Slideshow, no no Yes
presentations (also
with using SCC styles)
Can restore current no no Yes
session after crash of
browser or system
Plug-ins support yes, ActiveX yes Yes
only
Can do navigation yes, but only Yes, configurable Yes,

with Keyboard basic system keyboard shortcuts. configurable set
keyboard of shortcuts, and
shortcuts also Spatial
Navigation.
Moving with keyboard | no yes Yes

cursors all over the
page (marking
fragments of text,
copy, paste, etc.)
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Opening recently no no Yes
closed windows
Supports [Pv6 yes yes Yes
Supports Notepad no no Yes
Display Page Info no yes Yes
Management no/no/no yes/yes/no no/partly/yes
Pictures/forms/links

Interface Skins, themes and other featur

€S

Skin supporting no yes Yes, also for
forms on sites,
applicable
without browser
restart

Skins special effects - no yes

supporting

Change Interface color | no no yes

schemes

Side panel included yes Yes (Sidebar) Yes (Hotlist)

Can configure side yes, but with yes yes

panel limited range

Commercial banners no no yes, banner or

inside browser

text in ad ware

(integrated) version,
disappears after
registration

Functionality, using comfort and language versions

Scaling entire sites no no Yes,
additionally
with smooth
scaling of
images

Font scaling Yes (partly) yes yes, as element
of entire site
scaling

Possibility to set font | no yes yes

sizes and types of the

browser.

Possibility to set no yes yes

minimal font size of

the browser.

National versions yes, yes, yes

(other languages)

Search and downloadable tools
Download manager Yes (only in yes yes

integrated

MacOS version)
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Built in searchers / no/NA yes/yes yes/yes
configurable
Search in multiple no no yes
search engines and
announce back results
in browser window
Added components and creating web sites
Mail and news agent yes, standalone | yes, standalone yes, built-
integrated package n(M2)

(Outlook
Express)
HTML editor for web | no yes no
pages
View source of page yes, in selected | taking built-in tool taking selected
software software
View source of no yes no
marked fragments
Java Script console no yes yes
Debugger of no (only yes no
JavaScript information
about errors
encountered)
Structure and tags no yes yes
analyzer for HTML
Rich-Text editing Partly supported | yes no
integration
IRC (internet Relay no yes yes
chat) client
Standards support and other add-ons
XHTML support yes yes yes
CSS1/CSS2 support partly/very poor | yes/yes yes/yes
WML 1.3/2.0 support | no/no yes/yes yes/yes
ECMA Scriptsupport | no yes yes
DOM level Y2support | no/no yes/yes yes/yes
MathML language no yes no
Privacy and Security integrated
Passwords manager yes yes yes, Wand,
highlight fields
with login and
password
Encryption of all no yes yes
stored passwords
Stored user password | no yes yes
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most critical
repaired fast,
others within

Cookies manager yes, but limited | yes yes
functionality
Controlling of all no yes yes
script behavior
Security problems yes, a lot un- None none
reported patched holes,
sending
passwords, even
encrypted, on
Microsoft and
Alexa servers
Security problem Software faults | Software faults in the Software faults
handling availability recognized as coming version repaired

instantly, or
after some days

browser.

months,

sometimes up

to years
Frequency of detecting | Several times in | Rarely Rarely
security holes in the a month
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Most needed Software on the Computer

The computer is a very powerful device which today is used in almost every area.
Some of these areas are very specialized areas which require specific software o
work with.

But for most of the users —normal users and specialized ones- there is a list of
software which is most needed on their computers, and they can not continue
using their computers effectively without them.

Examples of such software are: Internet connections, e-mail clients, Internet
browsers, text editors, spreadsheets, movie viewer and image viewer.

Internet connections
To be able to use the Internet you have to create a connection to the
Internet. Many computers use a modem to dialup to the Internet: To do so
you have to create a new dial up connection with the configuration you get
from your ISP (Internet service provider).

E-mail clients
After successfully connected to the Internet, you may need to read and
send e-mails. You will need an e-mail client which can be a web based e-
mail client (which uses normal browser to connect) like Hotmail, Yahoo
and Gmail accounts. Or you can use Windows based e-mail clients which
is software run under Windows to connect to the e-mail client. It uses
Internet protocols like POP3, IMAP and SMTP protocols. Examples are
outlook, Eudora and Outlook express clients.

Internet Browsers
To navigate to the different places on the Internet and search for
information, checking your web-based e-mail, download and upload files,
you need an Internet browser like Microsoft Internet explorer, Netscape
navigator, Opera, ...and many others. Each of these browsers differ from
each other, which gives it suitability of specific category of users.

Text editors
Software for writing a letter, an essay, an eBook, or do your home work
with effectively. This is a tool that gives you very powerful functions like
spell checking, synonymous, choose to write in different languages,
integrate images, tables and multimedia files, print preview, print in

different page sizes, and many other functions.
Text editors like: Note Pad, Word Pad and Microsoft Office Word.

Spreadsheet
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Spreadsheets are software that deals with tables of data, with many
features like multiplying, summation, division and most of the arithmetic
operations. You can give the table a nice look by changing formats. You
can work with many tables in the same file.

Spreadsheets software examples are Lotus 123 and Microsoft Office
Excel.

Image viewer and editor
What if you have many pictures converted to a computer format by
scanning or taken by a digital camera and you want to see it on the
computer, or share it with others? You need an image viewer like Internet
explorer, or Microsoft image viewer.

But if you need to change the format of the file, resize it or do some
modifications to that image, you will need an image editor like Paint shop
pro or Adobe Photoshop Elements (which I use, btw.).

To view movies on the computer you need to have a multimedia viewer
like Windows media player.

There are many other software tools for managing the computer —which
are essential to work with the computer. Many of those tools can be found
under the Control Panel, like add new hardware, add/remove programs,
and managing users of the computer under computer management.
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Cookies
What Are They? Why Are You In Charge? And how can you delete them?

What’s a Cookie

A cookie is a very small text file written to your hard drive by a Web Page
server. It is basically your identification card, and cannot be executed like
code or deliver viruses. It is exclusively yours and can just be read by the
server that gave it to you.

A Cookie's Purpose

The purpose of the cookie is to tell the server (website) that you have
returned to that Web page.  Mainly, it saves you time: If you customize
pages, or register for services or products, a cookie helps Microsoft to
remember who you are.

Next time when you return, the website knows how to show you the
information you supplied last visit. Or, when you register for another
service or product, all what you need to do is to type in your e-mail
address and your password. Then, the website will fill in any questions
you've already answered.

Certainly, if you’ve never registered or left personal information at the
website, the server just knows that someone with your cookie has returned
to the Web site. You’re in charge of deciding if the website should know
anything about you. However, the more you tell them about yourself, the
more they can help you to find information or products that you want.

Just remember that you can always edit any personal information you give
Microsoft by using the Profile Center at
http://go.microsoft.com/?linkid=317027

How a Cookie May Help Microsoft

A Cookie allows a site to be more efficient. They can know what
information is important to their visitors, and what is not. they can discard
Web pages that you don't use, and center their efforts on information that
you need.
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If You Want to Control Which Cookies That You Accept
You can ask your internet browser to accept all cookies or to warn you
every time a cookie is offered. Then you can later decide whether to
accept one or not.

To do so, if you are using Internet Explorer:

1. Click Tools, then
2. Go to Internet Options.
3. Choose the Privacy tab,
4. Default setting is set to medium. Move the slider to decide which
setting you prefer.

5. You can also press on Advanced for specialized cookie treatment.
If you are using Netscape Communicator 4.0:

On the Task Bar, press:

Click Edit, then

Go to Preferences, then

Press on Advanced.

Change your options in the box that labeled "Cookies".

b

How to See Cookies You have accepted:
If you are using Internet Explorer 6.0 as your browser:
On your task bar, click:

Click Tools, then

Go to Internet Options.

Under the tab called General (which is the default tab) press
Settings, then from there

Go to View Files.

Nk W=
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How to delete cookies
Now, what would you do to the cookies already there on your PC?

I. First, Quit Internet Explorer and also quit any instances of
Windows Explorer.

2. Under Control Panel , open Internet Options.

3. On the General tab, press Delete Cookies under Temporary

Internet Files, and then press OK.
4. Press OK.
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Adding A Web camera

To add a Web camera to a computer setup isn't at all difficult. You just need to
remember that compatibility is the key.

The instant messaging clients are integrating videos more and more, therefore it's
been much easier, as technology news and reviews sources say. USB connections
on all computers are making it simpler to just plug it in. They are making it more
available for the average user.

Web cameras may cost from $20 to upward of $200. All of them are pretty
standard, with image quality generally improving with price.

A large number of people need a basic, a minimum of $40, you just want
something which is going to look decent and therefore that the other person will
be able see you.

The camera must be compatible with the computer. Logitech and Creative
manufacture popular brands of PC-compatible Web cameras, although smaller
companies make fine web cams, too.

Apple manufactures the iSight web cam, which is compatible with Macintosh
computers and works best with Macs. Logitech too makes a Mac-compatible Web
cam.

When you are shopping in any store for a web cam, the specifications are found
on the back, the Windows or Mac logo and also operating system requirements.

Web cameras are sold with software that allows the user to take still pictures and
make short movies that can be inserted into e-mails.

Also some software includes very special effects which will superimpose the
image of a shark or any other animated character over your face and also will
track and mimic your facial movements and gestures.

A large number of people use Web cameras for video instant messaging using
AOL, Yahoo or MSN's instant messaging (IM) programs, which are free of
charge and easy to download.

Logitech has a partnership with MSN Messenger, as a result it works very good
with that, but it will work with virtually anything.

The computer should have a USB port; most computers purchased in the last five
years do have one.

First, install the Web camera disc driver and software. Follow the instructions
included. Plug the camera into the computer: It should detect it. After that, start
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using it and using the software provided, or open up your instant messaging client
AOL, Yahoo or MSN and log on.

If T have MSN Messenger installed and want to video chat using the web cam
with you, you should also need MSN Messenger. Most often, the program has a
video message icon, therefore you can click on that, and the other person just has
to accept your feed. It's really very easy.

Also, most cameras have built-in microphones, so that users can talk and see the
other person without needing to use the computer microphone.

As with any technology, as prices come down and simplicity of use has improved,

they are growing (in use). When the normal user —not an expert— can easily install
and work with Web cameras, it will be found in every house.

© 2005 SilverCitizen.com



http://www.silvercitizen.com

Organizing your Folders 44

How do | create, deal with and organize my folders?
Creating folders for your work on your computer helps you to keep your files
organized as well as making it much easier to locate the files in the future when
you look for them. For example, you may want to organize your files in the
beginning of the semester by the classes you may have at school. You may create
a folder for each class on your hard disk, floppy disk, and zip disk or in your
Home Folder.

Create a Folder
Let’s assume I had created a folder on my Home Folder on hard disk or
floppy disk named it My Folder and I wished to create another folder for
my Communication Seminar. To create that new folder I would:

1. Open the folder which is called My Files

2. Pull down the poll down File Menu and select New then Folder
3. A folder is created called New Folder will appear, with the name

Highlighted. In the picture shown below the default name is New Folder.

& my files =101 x|

File Edit  ‘iew ngcl;as Toolz  Help -

| #mfoch -~ = - 2] | @Seach Folders »
| Address | my files ~] @6
#] TRG-chapter 1

__JTheSr:uftwareTm...

_-fmgninh:urm

New Falder

4. Type the name you wish to call the folder for your folder and it will
appear next to the folder.
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] The Software Tut.
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To simplify the process, to create a new folder you may follow these
steps:

1. Under "My Computer" locate the area in which you want to create that
new folder

2. Click “New" from the "File Menu"; then select "Folder". The new
folder appears with a temporary name — usually called New Folder.

3. Type a name for the new folder as you wish to call it, and press "Enter"

Note: Always remember to open the area you want to create the folder in
first.

If you are creating it on a floppy disk --- double click My Computer and
then go to (double click) the Floppy drive (3 1/2 Floppy (A:))
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How do I move and copy files and folders?
The easiest and fastest way for copying and moving files is to use the
‘drag and drop’ method. Using the mouse, you can copy and move files

and folders by dragging them from one location to another.
To use drag and drop method:

1. Open the window for the area that contains the file or files you wish to
copy. This is your Source.

2. Open the window for the area that you wish to copy the file to. This is
your Target.

3. Now, Drag and move the windows so you can see both of them
togeather.

4. Press and hold the mouse down and drag the file from your source
window - to your target window.

You can also use the copy, cut and paste commands from the Edit poll
down menu or you may use the shortcut keys; CTRL-X for cut, CTRL-C
for copy and CTRL-V for paste.

To Move a file to a new location (delete it from original place and copy it
to another):

1. Open the folder that has the file or files you wish to move.

2. Right click the mouse on the file and select Cut from the menu or press
once on the file to select it and pull down the Edit Menu and press Cut.
3. Open the folder where you want to move the file to (target) and right
click and press Paste from the pop-up menu.
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Firewalls
What could be the best combination of Internet security

and privacy services, hardware and software?
The practical answer is find products that meet your needs and do not
obstruct each other.
As an example, a three computer home network for two kids and two
adults, you may use the Norton Internet Security software suite (firewall,
anti-virus, privacy and content filters, etc...) or PestPatrol, BOClean,
IEClean, RoboForm, SpyBot Search & Destroy or Linksys Firewall
Router, and the SortOnce online email service plus anti-virus and spam
filters. You should set up Windows and Norton that are used for automatic
updates. PestPatrol, BOClean and SpyBot contain manual but also easy

one click updates.
If you are unfamiliar with these terms, you should get someone more

knowledgeable to help you.

With using DSL or cable modem service, every one of these updates is
fast. The layers of defense are the best approach, therefore you should
have two firewalls “software and hardware”, two anti-virus “online and
software”, and use three programs to fight Trojans, worms, spyware and
other pests: PestPatrol, BOClean and SpyBot. Search for these on the

Internet.
IEClean makes it simple to remove browser related files. RoboForm keeps

and protects track of your passwords and personal information.
How about interference? Using two software firewalls is not a very good
idea. This is why you must use a hardware and software combination. For
the anti-virus, use an online email service with back up by anti-virus
software on your computer: this is the best combination. Watch the
overlap of scanning by using PestPatrol MemCheck, Norton Anti-Virus,
and BOClean. Any problems may be resolved by turning off MemCheck.
How to uninstall a firewall?
Most of the people who ask this question got an error message whilst
using an online service as email, chat or music. If you didn’t install a
firewall and your computer isn’t connected to the Internet using a local
area network (LAN), make sure of the technical support FAQ at any
service that gave you the error message. If you’re on a LAN, check it with

the administrator.
The common way, turn the firewall off, after that, run the program's own

uninstaller utility, if present. Click Start, Programs, (Program Name),
Uninstall (Program Name) “or (Program Name) Uninstaller”. You'll be
asked usually to confirm that you want to remove the program, press OK.
If the application doesn't include an uninstall option, return to the
Windows Add/Remove feature. Click Start, Settings, Control Panel,
Add/Remove Programs. Choose the firewall from the list, and then click
Remove.
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A personal firewall is used for protecting your computer from scanning or
attack by hackers or script kiddies at the same time as it is connected to
the Internet.

You need both anti-virus http://www.firewallguide.com/anti-virus.htm and
anti-Trojan software http://www.firewallguide.com/anti-trojan.htm too.
Any combination of software and hardware doesn’t provide complete
security. Someone is always creating a new virus, worm, Trojan horse or
any other new way to break through a firewall. You must use products that
are updated on a regular basis via their vendors for protection from
attacks. Most of the Internet users can achieve a reasonable level of

security at a low cost.
Personal firewall software doesn’t give complete online security. At least,

you also need anti-virus software to supply a reasonable level of security.
You also may want software for email encryption, Trojan detection and
elimination, Virtual Private Networking for telecommuters, cookie
manager or cleaner, advertisement blocker, personal data privacy, and

parental controls for unwanted contents filtering.
If you have a DSL broadband connection, you need a personal firewall.

Try a free and easy online test, http://www.firewallguide.com/test.htm to
find out if your computer's ports are open to the Internet.

To know if personal firewalls work, install one and test it by using an
online testing service.

Windows XP firewall is a simple and effective protection from inbound
traffic, to control outbound traffic and also for other features.

A router sits between your modem and your computer or your network. It
is difficult to hack your computer or a network while it is hidden behind a
hardware box.

The best choice is a combination of personal firewall software otherwise
networking software with firewall features plus a hardware router with
firewall features.
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Personal privacy
These days, with the existence of the Internet, there are many ways in which your
online personal privacy can be compromised.
The following points are some tips for protecting yourself:

. Some Web sites —the number is growing everyday- require cookies in
order to allow you in or even navigate within the site, and it is not usually
practical to configure web browsers to automatically reject all cookies. However,
internet web browsers can be configured to ask for approval before accepting any

new cookies.
. On a periodic basis (could be daily or weekly), you should delete all these

stored cookies (or at least all cookies except those you specifically decide to
keep). Double-Click's "opt-out" mechanism relies on the placement of a special
cookie on your computer (i.e., you must trust Double-Click that it will not track

your actions using this special cookie).
. Configure your browser to deal with more than one user profile. This will,

in effect, give you multiple identities. You could also want to review the different
software programs that can handle and manage multiple online identities.

. Install "ad blocking" programs on your computer. If the display of an ad is
suppressed, your internet browser will not start a communication with the ad
management company.

. Install a personal firewall program on your computer which requires you
to explicitly authorize every software product that is permitted to communicate
with the outside sites. This will for sure reduce your vulnerability to programs
which install things like "Trojan horses" which can be used by internet hackers to

access your computer.
. Do searches for new domain names (if you plan a website) only on good

reputation domain name databases and servers. An unscrupulous operator of a
domain name database may review logs of latest searches and then register names

which were searched but not instantly registered.
. Do confidential Web keyword searches only on Internet search engines

which do not allow third parties to view latest searches. Most popular search
engines allow third parties to observe searches being performed on their indexes.
Links can be checked at www.LegalPortal.ca if you desire to see how this works.

. Avoid using services like Alexa (www.alexa.com) which is used mainly to
track you around while you surf the internet.

. If you use Internet browsers like Netscape Navigator, make sure to turn
off the "Smart Browsing / What's Related" features.

. Be sure your internet browser does not identify your e-mail address. Such
addresses can be very easily extracted by Web sites you visit.

. If possible, avoid subscribing to what is called "always on" Internet

service (such as from your cable company) if the company will assign your PC an
Internet Protocol address —IP Address - which will stay constant.

. If you wish to visit Web sites with greater secrecy, consider using a
service such as Anonymizer .
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. Delete confidential client documents from your computer after you finish
working on them and copied them to your office computer.

. Use virus protection program to scan all new programs you download
from the Internet.

. Avoid buying a computer with an Intel Pentium III processor unless it
allows you to turn off the ability to get the unique serial number embedded in the

processor.
. When installing new programs that requires registration, choose the offline

registration mechanism (for instance, print and fax the registration) rather than
allowing the programs to deal with the vendor directly through the Internet.

If you use Internet-based e-mail software, including Outlook, turn off every split-
window display which shows the contents of an e-mail message which is selected
in another window. Delete - without reading - any new messages that appear to be
un-welcomed advertisements.

NEVER open attachments in emails from senders you don’t know and trust.
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Microsoft Word Basic Functions

Entering a new and Editing Text
Entering text in MS word is simple: just start typing. Characters will
instantly appear as you enter them. If a line is full, your text will
automatically wrap around to the next line.
You may move to the next line manually by pressing Enter from the
keyboard, but you have to do so only if you intend to start a new

paragraph.

If you wish to insert new text between text already typed, just point to
where you wish to insert text and press the left mouse button. You will
then see a blinking insertion point at that position, and new text will be
inserted at that point, pushing the text after that to the right (wrapping it
automatically if necessary).

To delete any text behind the cursor, use the Backspace key from the
keyboard. To delete text in front of the cursor, use the Delete key from the
keyboard. To move up and down in the document, you should use the
scroll bars at the right of the document.

Selecting and Moving Text in the document
You may cut, copy, and paste all or part of the text at any time you wish.
First, select the text, (Click and hold down at the start of the text, drag the
mouse over the wanted text), then choose Cut (Copy and Remove) or
Copy from the Edit Menu to put a copy of the text into the clipboard.

Finally, you may move to the new location for the text, left click, and
choose Paste from the Edit Menu.

<7 Undo Paste ChrHZ

& cut ek
B Copy ChilC
B paste Chrl+y

Select Al CrH-A

#h Eird... ChrF

o

When you choose Edit from the menu bar you will see the above pull-
down menu, from which the icons and operations to which they
correspond will show. "Shortcut" keys will appear on the standard toolbar.
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Undoing and Repeating the Last Action done
In many cases where you have deleted something you did not wish to
delete, or when you have entered anything that you did not want to add,
you may need to undo that action. On the standard toolbar there are two
buttons with curved arrows that are the Undo and Redo commands
respectively. When the Undo Button is clicked, you can choose to undo up
to the last one hundred actions you have done. Redo will redo the last
action which you "undid."

Another useful way of finding these commands is to press the Edit button
on the Menu. At the top of that drop down list the Undo and Redo
commands appear. The shortcut key for this action is Ctrl + Z (Press down
the Ctrl key: While holding it down, press the Z key).

Undo and Redo can be used to recover from almost any error you can

make in Word. However, there are a few errors, such as closing a file
without saving your changes, from which you can’t recover so easily.
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Adding Headers, Footers, and Page Numbers to
documents
Usually you will want to add headers, footers, and page numbers to longer
documents. Headers and footers are found under the View Menu, while
Page numbers can be inserted directly from the Header/Footer Tool Bar.

To add a header or footer to your document, just select the Header and
Footer option from the View Menu. The body of your document will
appear in gray while the Header or Footer and the Header/Footer Tool Bar
appear as shown in below.

Header

i Header and Footer

Insert AukoText = BB o 5 F O, | dose

File Edt View Insert Format Tools Table ¥

) New, . ChriN

e
|

The above image displays the header to this document.
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Saving a text to a file
There are three ways to save your text to a file. You can use the icon on
the tool bar, the Save or Save As Commands in the File pull down menu,
or the keyboard command, Ctrl + S.

File Edit View Insert Format Tools Table W

[ New... Chri+N Evt
(= Qpen... Gk

=

5&"!"& ESHl
Lﬁ Save as \Web Page...

If you have selected Save As or if you have not previously saved the file,
you will be asked for a drive and folder to save to. If you have not named
your document or if you wish to give this version of the document a new
name, you should do that now.

The Save As command permits you to save a file under a different name
while preserving the original file. This is very helpful especially in cases
when you want to have multiple versions of the same document.

Opening a File -~

To open a file you want to use the icon on the tool bar &% or you may
use the pull down selection in the File pull down menu.

Gl Document3 - Microsoft Word
| File Edit ‘iew Insert Format Tools Table Wind

[ pew.. crieN @R <t
1 { : Chrl+0O ; 1
ri+ 1z B
;‘_353 f——————
r
& save Ctrl4S

The third way is to depress Ctrl + O on your keyboard.

After successfully opening a document you may begin your work with the
document (additions, deletions, and revisions).

Printing a File

To print, press on the icon on the tool bar &
or choose the Print option from the File pull down menu.
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You may wish to preview how your document will look after printing

either by clicking on the icon for "Print Preview" on the tool bar m or by

selecting it from the drop down menu.

After choosing to print you will be given a number of choices:

You will be able to select which printer you wish to print to through the
use of a drop down menu. In this menu all printers available to you are

listed there.

You also have a choice as to how much you want printed. You may
choose to print your whole document or just a certain page, or selection of

pages.

21X

—Frinter
Marme: I 5 Canon MP360 Series Printer ;I Propertizs |
Status: Idle - Find Printer... |
Type: Zanon MP360 Series Printer
wWhere: USEO01 [ Print ta file
Commenk: [T Manual duplex
—Hage range -_opies
i+ g Mumber of copies: 0
& Current page € Selection
" pages! v Collate
Erter page numbers andfor page ranges
separated by commas, For example, 1,3,5-12

Print what ID-:u:ument

Pririt: |.ﬁ.II pages in range

opkions...

—Zoom

Pages per sheet: |1 page

=

Scale to paper size: II"-J-: Scaling

#]

o« |

Cancel |
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images and clip art in Microsoft Word
Microsoft Word makes it so easy for everyone —especially normal users who care
to deal with that powerful piece of software-to add an image into their document.
You can insert an image of many file formats like (JPG, BMP, TIF,GIF .. and
many others) into your document.The image can be inserted in between lines or
even in a table based on the user needs.
Inserting a Graphic in the Document
To insert a new graphic in a document, you may position the insert point
to where you want to place the graphic. Then select Picture from the
insert menu. Click on the Clip art, and double-click the graphic you want

to use.
1. Select Insert, Picture, Clip Art or click the Insert Clip Art on the

Drawing toolbar.

2. Microsoft Word opens the Clip Art Task Pane. To choose from.

3. Search for a specific clip image by putting what you are searching

within the Search field in that Task Pane.

4. Alternately, you may click on the Clip Organizer button toward the

bottom of the Task Pane to open the Clip Art Organizer.

5. Select the clip you wish and when Word shows a control palette,

you may choose the first option, Insert Clip. The clip is then inserted

where your insertion point is positioned in the document.

6. You can also drag and drop the clip art into your document.

NOTE: You can’t view graphics in a document if you are in Normal

Viewing mode. Switch to Page Layout in order to see your graphic.
How to wrap Text around a Graphic

By default text does not wrap around any graphic. To get text to wrap

around a graphic, you may do the following:

1. Right click on the graphic to make the short cut menu appear.

2. Choose Format Picture from the list displayed.

3. Select the Layout tab.

4. Choose the style of wrap that you like and click OK.
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How to resize a Picture

. Select the inserted picture by clicking once on it.

. Click the Cropping tool on the Picture toolbar.

. Notice that the mouse cursor has changed.

. Drag one of the corners with the pointer to reduce its size and

eliminate it.
If you wish to do modification to the image or even change thelayout
options, click the image once. From the menu called Format, choose
Picture... . From the Format Picture window which will appear, you can
easily change the image's size, color, text wrapping, and many
characteristics.

Insert clip art image

1. Click the menu called Insert, point to Picture and click Clip Art.

2. Browse the Clip Gallery to find the file to insert it.

3. Drag the picture to wherever you wish it.

Microsoft Word contains a full set of Image tools. By using them you can:

. Create new graphics from scratch
. Import previously created graphics from other programs
. Place graphics within text in the document

MS Word comes with a lot pre-designed graphics that are installed in the
hard disk under the folder called MSOFFICE\CLIPART. These graphics
can be used, resized and placed within text.
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Virus, Worm, Trojan horse and spam
The most common mistake when the topic of a computer virus arises is that
people will often refer to a Worm or Trojan horse as a Virus. While the words
Trojan, worm, and virus are used interchangeably, they never mean the same.

Viruses, worms, and Trojan horses are all malicious software that can cause
damage to your computer, but there are differences between the three, and
knowing those differences can help you to protect your computer from their often
highly damaging effects.
Computer Virus
A computer virus attaches itself to a program or a file so it can
spread from one computer to another, leaving infections as it
travels between computers. Much like any human viruses,
computer viruses can range in severity; some viruses cause only
mildly annoying effects while others can completely damage your

hardware, software, or files.
Almost all computer viruses are attached to an executable file,

which means the virus can exist on your computer but it can’t
infect your computer unless you run or execute the malicious
program. It is very important to note that a virus can’t be spread
without a human action, (such as running an infected program) to
keep it going.
People continue the spread of a computer virus, mostly
unknowingly, by sharing infected files or sending e-mails with
viruses as attachments in the e-mail.

Worm
A worm is similar to a virus by its design, and —somehow- is
considered to be a sub-class of a virus. Worms spread themselves
from computer to another, but unlike a virus, it has the ability to
travel without any help from the user.

A worm takes advantage of file or information transport features
on your computer, which allows it to travel unaided. The biggest
danger with a worm is its ability to replicate (copy) itself on your
computer, so rather than your computer sending out a single worm,
it may end up sending out hundreds or thousands of copies of
itself, creating a huge devastating effect.

One good example would be for a worm to send a copy of itself to
everyone listed in the e-mail address book. Then, the worm
replicates (copies) and sends itself out to everyone listed in each of
the receiver's address books and so on.

Due to the copying nature of a worm and its ability to travel across
different networks, the end result in most cases is that the worm
consumes so much system memory (or network bandwidth),
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causing internet Web servers, network servers, and individual
computers to stop responding. All users remember the Blaster
Worm, the worm that was designed to tunnel into your system and
allow malicious users to get control over your computer remotely.

Trojan horse
A Trojan horse is full of as much scam as the mythological Trojan
horse it was named after. The Trojan horse, at first glance, will
look like a useful piece of software, but will actually do damage
once installed or run on your computer.

Those users who are on the receiving end of a Trojan horse are
usually tricked into opening them because they look like to be
receiving legitimate software or files from a legitimate source.
When a Trojan is activated on the computer, the results can vary.
Some of the Trojans are designed to be more annoying than
malicious (like doing changes to your desktop, adding very silly
active desktop icons) or they can cause serious damage by deleting
any files and destroying information on your computer.

NEVER double-click on a file with an .exe extension unless you
are absolutely certain that this is a program you are familiar with or
you trust the sender of it.

Spam
If you read e-mail from someone (may be you know) and you find
out later that this person did not send you the e-mail, this means
that this e-mail is spam.

Protecting yourself
The first steps to do protecting your computer are to ensure your operating
system (OS) you have is up-to-date with the latest updates. This is
essential if you are running a Microsoft Windows OS.
Secondly, you should have recent anti-virus software installed on your
system and ensure you download updates on regular basis to ensure your
software has the latest fixes for new viruses, worms, and Trojan horses.
Additionally you want to make sure your anti-virus program has the
ability to scan e-mail and files as they are downloaded from the Internet or
network before they reside on your computer.
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